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TÓM TẮT
Bài báo trình bày kết quả nghiên cứu mô phỏng thủy động lực học chuyển động của tàu thủy trên sóng, bắt đầu từ 

việc xây dựng mô hình một tàu chở hàng cụ thể trong phần mềm thiết kế tàu thủy Autoship, sau đó chuyển sang AQWA, 
môđun phân tích thủy động lực học của phần mềm ANSYS để thực hiện mô phỏng và phân tích chuyển động của mô hình 
tàu này trên sóng bằng phương pháp tính toán động lực học chất lỏng (Computational Fluid Dynamics - CFD). Kết quả 
mô phỏng thủy động lực học sẽ là cơ sở để giải các bài toán liên quan đến chuyển động tàu trên sóng như tính biên độ dao 
động, tính sức cản, phân tích ảnh hưởng sóng, tải trọng trên tàu đến chuyển động tàu v..v…        

Từ khóa: mô phỏng thủy động lực học, phần mềm AutoShip, AQWA - ANSYS, RAOS

ABSTRACT
This paper presents the research results of hydrodynamic simulation ship motion in regular wavea. Beginning from 

building the model of cargo ship by Autoship - ship design software to importing to AQWA - Hydrodynamic module of 
ANSYS orders to simulate and analyse ship motion in regular waves by Computational Fluid Dynamics - CFD. This 
hydrodynamic simulation results will be basic to solve the problem concerning to ship motion in regular waves such as 
caculate Response Amplitude Operators (RAOS), ship resistance, effecting of regular waves, load to ship motion etc. 

Keywords: hydrodynamic simulation, AutoShip software, AQWA-ANSYS, RAOS

1 PGS. TS. Trần Gia Thái: Khoa Kỹ thuật giao thông - Trường Đại học Nha Trang
2 CFD là chữ viết tắt của cụm từ tiếng Anh “Computational Fluid Dynamics” đã được sử dụng phổ biến, do đó chúng tôi 
sẽ sử dụng thuật ngữ viết tắt này trong suốt các nội dung của bài báo

THOÂNG BAÙO KHOA HOÏC

I. ĐẶT VẤN ĐỀ  
Tính toán động lực học chất lỏng (Computional

Fluid Dynamics - CFD)2 là một phương pháp tính 
mới, được xây dựng trên cơ sở kết hợp giữa 
phương pháp số và công nghệ mô phỏng trên máy 
tính để giải những bài toán liên quan đến chuyển 
động của dòng chất lỏng hoặc dòng chất khí bao 
xung quanh vật thể bất kỳ. Nó hiện đang được 
ứng dụng rộng rãi trong nhiều lĩnh vực nhằm tổ 
chức thực nghiệm ảo trên máy tính thay cho thực 
nghiệm mà nhiều khi, việc tổ chức thực nghiệm thật 
có thể rất tốn kém hoặc không thể thực hiện. Với 
vai trò quan trọng như thế nên CFD được các nhà 
khoa học nhìn nhận như là “phương pháp thứ ba”, 
cùng hai phương pháp nghiên cứu truyền thống là 
nghiên cứu lý thuyết thuần túy và thực nghiệm thuần 
túy,   trong tổ chức nghiên cứu và phát triển những 
ứng dụng kỹ thuật trong rất nhiều lĩnh vực khoa 

học khác nhau. Trong những năm gần đây, CFD đã 
được vận dụng rộng rãi trong mô phỏng dòng chất 
lỏng chảy xung quanh bề mặt thân tàu, nhằm khảo 
sát các hiện tượng thủy động lực học xuất hiện khi 
tàu chuyển động trên sóng. Với ý nghĩa đó, bài báo 
này trình bày kết quả của chúng tôi trong nghiên 
cứu ứng dụng phương pháp CFD, bằng cách sử 
dụng AQWA ANSYS - một môđun tính toán thủy 
động lực học của bộ phần mềm Ansys, để thực hiện 
việc mô phỏng và tính toán thủy động lực học cho 
một tàu cụ thể. 

II. PHƯƠNG PHÁP VÀ NỘI DUNG NGHIÊN CỨU
Về mặt phương pháp, sóng biển tự nhiên dùng 

trong nghiên cứu các chuyển động có chu kỳ của 
tàu thủy được xét như là tập hợp của vô số sóng
điều hòa biên độ nhỏ, có tần số và chu kỳ khác 
nhau, pha ngẫu nhiên. Phản ứng của tàu với nhiều 
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sóng điều hòa có biên độ, tần số khác nhau, pha 
ngẫu nhiên, tác động đồng thời, được xét như là 
một quá trình ngẫu nhiên, sẽ là tập hợp của các 
phản ứng riêng lẻ của tàu với từng con sóng.      

Khi đó, tính toán thủy động lực học của tàu 
trên sóng là nhằm xác định phản ứng của tàu trên 
sóng điều hòa, thông qua việc xác định các thông số 
dao động của tàu với biên độ và chu kỳ phụ thuộc 
biên độ, tần số sóng, cụ thể như các yếu tố thủy 
tĩnh (Hydrostatic), thủy động học (Hydrodynamic), 
biên độ dao động của tàu (Response Amplitude 
Operators - RAOs), phân bố của áp suất thủy động 
lực học (Hydrodynamic pressures) và các chuyển 
động của tàu trên sóng (motions), các lực cưỡng bức 
(lực Froude - Krylov), hệ số cản… Cho đến hiện nay, 
bài toán thủy động lực học tàu thủy thường được giải 
bằng kỹ thuật CFD ứng dụng cho dòng chất lỏng chảy 

bao xung quanh thân tàu thủy, kết hợp thực nghiệm 
để kiểm định lại mô hình tính [3]. Do đó hiện nay cũng 
đã có nhiều phần mềm CFD như AQWA dùng để 
phân tích thủy động lực học tàu thủy.  Tuy nhiên, vấn 
đề đặt ra ở đây là việc xây dựng mô hình thực tế của 
tàu tính toán trong các phần mềm như thế gặp nhiều 
khó khăn vì hình dạng phức tạp của thân tàu và khả 
năng tiếp nhận chính xác mô hình tính [1].

Trong nghiên cứu này, chúng tôi giải bài toán 
đặt ra trên cơ sở sử dụng phần mềm thiết kế tàu
Autoship xây dựng chính xác mô hình tàu và chuyển 
nó sang môi trường CFD trong môđun phân tích 
thủy động lực học AQWA của ANSYS để thực hiện 
các tính toán thủy động lực học theo trình tự giải bài 
toán CFD đã biết. Một cách tổng quát, có thể tóm tắt 
phương pháp và nội dung nghiên cứu bằng sơ đồ 
như mô tả trên hình 1.

Xây dựng mô hình 
tàu trong Autoship

Chia lưới và thiết lập các 
điều kiện biên 

Tính toán và thiết lập các thông số 
vật lý của mô hình trong CFD

Chuyển mô hình tàu sang tính toán
CFD trong AQWA ANSYS

Tính toán và phân tích thủy 
động lực học mô hình tàu đang xét

Hình 1. Sơ đồ quá trình nghiên cứu
Trong phạm vi của bài báo này, chúng tôi sẽ 

trình bày cụ thể kỹ thuật xây dựng và thiết lập 
các thông số của một mô hình tàu cụ thể trong 
môi trường AQWA để tính và xuất kết quả tính 
thủy động lực học tàu. Trong bài báo tiếp theo, 
chúng tôi sẽ trình bày kết quả tính đối với mô 
hình tàu đã có số liệu thực nghiệm để có thể so 
sánh, đánh giá kết quả tính từ phần mềm với số 
liệu thực tế.

III. KẾT QUẢ NGHIÊN CỨU VÀ THẢO LUẬN
Quá trình xây dựng và thiết lập các thông số 

mô hình tàu tính toán trong AQWA thực hiện theo 
trình tự:

1. Xây dựng mô hình tàu trong phần mềm thiết 
kế tàu Autoship

Tiến hành xây dựng trong phần mềm thiết kế tàu 
Autoship mô hình của một tàu chở hàng dạng hông 
tròn, mũi và đuôi có dạng quả lê, bố trí thêm một chân 
vịt đẩy ngang ở mũi và có các kích thước chính như sau:

- Chiều dài toàn bộ (overall length):  L = 24 m;
- Chiều rộng (breadth):  B = 6 m;
- Chiều cao mạn (depth):  H = 3 m;
- Bán kính hông:  r  = 1 m;
Gốc tọa độ được đặt tại vị trí giao điểm giữa 

thân tàu với phía dưới sống chính (keel) của tàu 
(hình 2). Trình tự thực hiện bài toán này được trình 
bày cụ thể trong tài liệu [3] của cùng tác giả.

                          Hình 2. Mô hình tàu hàng khảo sát                   Hình 3. Mô hình tàu hàng dựng trong Autoship 
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Sau khi dựng xong mô hình, tiến hành tạo thành 
một nhóm chung cho toàn bộ các bộ phận tàu đã 
dựng, sau đó nhấp chuột vào mục View và chọn 
mục Render để tô bóng toàn bộ mô hình tàu như mô 
tả trên hình 3. Lưu lại mô hình tàu này dưới dạng 
fi le có đuôi .iges bằng cách chọn mục File → Export 
→ IGES → chọn nơi lưu và tên fi le mô hình tàu, 
ví dụ ship.igs → chọn Yes trong hộp câu hỏi: “Split 
Objects at Corners?” → nhập trong hộp thoại Accep 
table Tolerance (m) giá trị 0.01 → OK.   

2. Nhập mô hình tàu vào môđun AQWA của Ansys
- Khởi động Ansys Workbench → chọn mục 

Unit trên thanh công cụ để thiết lập hệ đơn vị → 
chọn các mục Metric (kg, m, s, …) và Display Values 
in Project Units (hình 4).

- Nhấp đôi chuột hoặc nhấp và kéo thả mục 
Hydrodynamic Diffraction của môđun AQWA từ hộp 
Toolbox của Workbench vào vùng Project Schematic
(hình 5) [1].

    
  Hình 4. Thiết lập hệ đơn vị            Hình 5. Màn hình khởi động Hydrodynamic Diffraction 

- Nhấp chuột phải vào ô Geometry → Import 
Geometry → Browse → chọn tập tin mô hình tàu 
đã dựng trong Autoship → nhấp Open để mở tập 
tin này → Nhấp phải ô Geometry → chọn mục Edit 
Geometry để mở Design Modeler → chọn  meter là 
đơn vị chiều dài → OK để nhập mô hình tàu vào môi 
trường Hydrodynamic Diffraction - Design Modeler 
→ chọn ô Detais View và thay đổi các mục Simplify 
Topology: Yes → Tolerance: Loose để có thể sửa lỗi 
tập tin .igs → Chọn mục Generate để tạo ra mô hình 
hình học trong Design Modeler.

3. Xác định mặt phẳng đường nước và đường nước
- Cắt mô hình tàu ở vị trí mớn nước để phân 

chia thành hai môi trường nước – không khí bằng 

cách nhấp chọn mục Tools → Freeze (giúp hợp nhất 
mô hình thành một phần tử để có thể thực hiện chức 
năng cắt – slice) → mô hình sẽ trở nên trong suốt 
→ Định nghĩa mớn nước tàu bằng cách nhấp mục 
Creat → Slice → chọn XYPlane (chọn mặt phẳng 
XY làm mặt thoáng nhằm phân cách môi trường 
nước và không khí) → chọn mục Apply trong ô Base 
Plane trong hộp Details View → nhấp chọn Generate
để hoàn tất các thủ tục (hình 6).

- Rê và nhấp chuột trục Y để đưa tàu về mặt 
phẳng ZX → chọn mục BodyOp1 trong ô Tree 
Outline → nhập vào ô FD5 Z Offset giá trị -1 (xác 
định vị trí mớn nước) chia mô hình tàu thành phần 
trên mặt nước và dưới mặt nước → ấn Enter → 
nhấp Generate để hoàn tất các thủ tục (hình 7).

          
                     Hình 6. Xác định mặt phẳng mớn nước tàu             Hình 7. Xác định mớn nước tàu
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4. Thiết lập các thông số vật lý cho mô hình 
mô phỏng

- Trong hộp Hydrodynamic Diffraction nhấp 
đôi chuột vào mục Model để nhập mô hình tàu vào 
môi trường của Hydrodynamic Diffraction (ANSYS 
AQWA - HYDRO - DIFFRACT).

- Thiết lập hoặc bổ sung các thông số vật lý của 
mô hình tàu đang xét trong ô Details of Geometry,
trong đó tối thiểu cần phải chọn thông số Point 
Masses (PMAS) để mô tả ma trận khối lượng tàu. 
Đối với mỗi mô hình tàu hoặc một cấu trúc xác định, 
cần cung cấp một yếu tố khối lượng điểm. Điểm này 
được chèn trong cây tập hợp các phần tử tàu bằng 
cách nhấp chuột phải mục Ship Hull → Add → Point 
Mass (hình 8). Ở đây có hai tùy chọn:

Nhập trực tiếp giá trị khối lượng tàu bằng cách 
nhấp vào mục Point Mass trong ô Tree Outline và 
nhập trực tiếp các giá trị cần thiết vào ô Details of 
Point Mass. Ví dụ, chọn giá trị quán tính khối lượng 
là via Radius of Gyration để nhập trực tiếp dữ 
liệu vào.

Tính tự động khối lượng tàu dựa vào chuyển 
động của tàu bằng cách chọn ô Mass Defi nition là 
Program Controlled (tức do chương trình kiểm soát) 
và nhập các số liệu Z (VCG) = - 4m và giá trị các hệ 
số nước kèm theo (hình 9), được xác định theo đề 
nghị của chương trình là [1].

kxx = 0.34B = 0.34x6  =  2.04
kyy = 0.25L = 0.25x25  =  6.25
kzz = 0.26L = 0.26x25 =  6.50

                
               Hình 8. Cách gán khối lượng cho mô hình tàu   Hình 9. Nhập giá trị khối lượng cho mô hình tàu

4. Chia lưới (Mesh)
- Thiết lập thông số lưới bằng cách nhấp phải 

Mesh trong Outline và nhập vào ô Details of Mesh 
giá trị Defeaturing Tolerance = 0.5, Max Element
Size = 0.9, chọn Meshing Type là Program 
Controlled để chương trình tự kiểm soát việc chia lưới. 
Tiếp tục nhấp phải mục Mesh trong mục Outline → 
chọn General Mesh để chương trình tự động tạo lưới

chia cho mô hình tàu (hình 10). Có thể thay đổi 
thông số để tạo lại lưới chia nhưng lưu ý lưới càng 
nhỏ, độ chính xác cao nhưng quá trình tính sẽ rất 
lâu, do đó nên chọn kích thước lưới chia sao cho 
phù hợp [1].

- Nhấp vào mục Units trên thanh công cụ để 
định dạng lại hệ đơn vị cho bài toán, trong đó lưu ý 
thay đổi tần số từ rad/s sang Hz.

 
Hình 10. Chia lưới mô hình
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5. Tính toán và phân tích (Analyze)
Đến đây, mô hình tàu khảo sát đã được 

chuẩn bị sẵn sàng cho việc tính và phân tích thủy 
động lực học, với các công cụ dùng cần thiết đã 
có sẵn trong mục Outline như Analysis Settings 
(Thiết lập các phân tích), Structure Selection (Lựa 
chọn kết cấu), Wave Directions (hướng sóng), 

Wave Frequencies (tần số sóng) …  Ví dụ hình 11 
là menu nhập giá trị các thông số sóng điều hòa 
với tần số 0.538 Hz, chiều cao sóng 0.25 m. Bạn 
cũng có thể nhập vào giá trị các tần số và chu kỳ 
sóng khác nhau để tạo thành hệ thống sóng ngẫu 
nhiên tác dụng lên tàu như đã trình bày trong 
phần trên (hình 12).

                    
  Hình 11. Menu nhập các thông số sóng                      Hình 12. Menu nhập các tần số sóng khác nhau

Sử dụng công cụ Solve Hydrostatics hoặc nhấp 
phải mục Hydrodynamic với hai tùy chọn (hình 12): 

- Calculate hydrostatics only (compute displacement 
and small angle stability parameters) dùng để tính 
toán thủy tĩnh, gồm tính toán lượng chiếm nước và 
các thông số ổn định ở góc nghiêng nhỏ.

- Compute full hydrodynamic properties and 
results dùng tính đầy đủ thủy động lực học.

Trong quá trình phân tích, chúng ta có thể chèn 

thêm những tùy chọn để xuất ra các kết quả tính toán. 
Điều này có thể được thực hiện trước hoặc thực hiện 
sau khi quá trình phân tích mô hình đã thực hiện 
xong. Các kết quả tính có sẵn gồm có Hydrostatic,
Hydrodynamic, Pressures and Motions và các kết 
quả chèn thêm như Hydrostatic Table (Bảng tính thủy 
tĩnh), Hydrodynamic Graphs (Biểu đồ thủy động lực 
học) v..v… Đánh giá tất cả kết quả chọn lựa và trình 
bày hay cập nhật (presented/updated) (hình 13) [1].

                          
                                         Hình 13. Chọn lời giải                          Hình 14. Các tùy chọn tính thủy động lực học tàu 
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6. Xuất kết quả
- Lựa chọn các tùy chọn xuất kết quả có trên 

thanh Properties và Hydrodynamic graphs (hình 15) 
để xuất kết quả tính hoặc các đồ thị và hình ảnh 
tương ứng, ví dụ như kết quả tính các yếu tố 

thủy tĩnh (Hydrostatics) (hình 15), đồ thị biên độ 
dao động của tàu (Response Amplitude Operators - 
RAOs) (hình 16), phân bố áp suất thủy động lực học 
(Hydrodynamic pressures) (hình 17) và các chuyển 
động của tàu trên sóng (motions) (hình 18) [2].

           
                Hình 15. Kết quả tính các yếu tố thủy tĩnh        Hình 16. Đồ thị biên độ dao động của tàu 

        
Hình 17. Hình ảnh phân bố áp suất thủy động lực học khi tàu chuyển động trên sóng điều hòa

Hình 18. Hình ảnh phân bố các sóng xung quanh thân tàu chuyển động 
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IV. KẾT LUẬN 
Kết quả nghiên cứu cho phép rút ra một số kết 

luận sau:
- Khả năng sử dụng kết hợp phần mềm thiết kế 

tàu Autoship và phần mềm phân tích CFD là AQWA 
ANSYS để thực hiện mô phỏng và phân tích thủy 
động lực học cho bài toán tàu chuyển động trên 
sóng là khả thi. Kết quả này cũng đã được chúng tôi 
sử dụng để khảo sát mô hình tàu đã có đầy đủ số 
liệu thực nghiệm và sẽ được trình bày cụ thể hơn 
trong bài báo tiếp theo.

- Kết quả nghiên cứu cũng sẽ là cơ sở quan 
trọng để giải quyết nhiều bài toán hiện vẫn chưa 
có được phương pháp nghiên cứu và lời giải 
chính xác như tính sức cản, phân tích ảnh hưởng 
của sóng biển, của các tải trọng trên tàu, kể cả tải 
trọng lỏng đến chuyển động của tàu, ảnh hưởng 

của lắc v..v… Kết quả nghiên cứu sẽ mở ra nhiều 
hướng nghiên cứu quan trọng trong lĩnh vực kỹ 
thuật tàu thủy, lĩnh vực vẫn còn nhiều vấn đề chưa 
được nghiên cứu triệt để bởi hạn chế về điều kiện 
thực nghiệm, thậm chí trong nhiều trường hợp là 
không thể thực hiện được, nhất là ở điều kiện kinh 
tế - kỹ thuật vẫn còn nhiều hạn chế như nước ta 
hiện nay.   

- CFD có vai trò và ý nghĩa rất quan trọng, đã và 
đang được ứng dụng rộng rãi trong nhiều lĩnh vực. 
Tuy nhiên ở nước ta hiện nay, đây vẫn còn là một 
lĩnh vực mới và chưa có nhiều kết quả ứng dụng. Vì 
vậy kết quả nghiên cứu của đề tài cũng sẽ là cơ sở 
để phát triển lĩnh vực nghiên cứu mới mẻ này trong 
công tác nghiên cứu khoa học và đào tạo sau đại 
học ở khoa Kỹ thuật giao thông của Trường Đại học 
Nha Trang. 
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